Quick Reference Guide 8
Outlook 2010 for Windows
Tasks

Outlook Tasks Folder

As with other Outlook main folders, the Tasks folder has multiple tabs with various commands which displays as a
ribbon; the commands are organized in logical groups. The tabs replace the menus in previous versions of Outlook.
Below are screenshots of the command tabs for the Tasks folder.

To display the Tasks folder, click the Tasks icon in the Navigation Pane, or press Ctrl+4.
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Folder Command Tab: New, Actions, Share and Properties
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View Command Tab: Current View, Arrangement, Layout, People Pane and Window
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Customize the Quick Access Toolbar New Tasks

As with the Quick Access Toolbars throughout Office 2010, each Outlook new item window has its own Quick Access
Toolbar that can be customized by the user. Steps to customize the Quick Access Toolbars throughout Outlook are
outlined in the Outlook 2010 for Windows QRG 1 - Getting Started.

I I D For software training, contact the Computer Training Center (CTC) at 358-1111 or visit the CTC Web
_ ;

——————— | site at http://itcd.hg.nasa.gov/ctc.
Information Technology &

Communications Division

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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The Task Views

When displaying the Tasks, the Home Tab and the View Tab include commands for several default views: Detailed,
Simple List, To-Do List, Prioritized, Active, Completed, Today, Next 7 Days, Overdue and Assigned views. In
addition, the To-Do Bar can be enabled and includes a Date Navigator, Appointments List, Tasks List and/or Quick
Contacts. To learn how to customize views, see the Outlook 2010 for Windows QRG 4 - View Customizations.
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Calendar with Daily Task List View

Another view that is beneficial is a combination of the Calendar g
with the Daily Task List displayed below each day (shown right). e L == l

With this view enabled, you will have a very good idea of the - —
meetings for the day along with projects to be started or due. e e

HQ-CAL-CTC 1

1. Click the Calendar icon in the Navigation Pane. T

£
HQ-CAL-CTC ~

2.  Click View Tab | Daily Task List to display a drop-down menu.

3. From the drop-down list, click to display Normal, Minimized, g
or Off. g

4.  Click Arrange by to select to display by Start Date, by Due
Date, and/or Show Completed Tasks.

The Daily Task List View will then display at the bottom of each
day in the Calendar.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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To-Do Bar
1. Toenable/disable the To-Do Bar, click View Tab | To-Do Bar. Select to display Normal,
Minimized or Off.

2. Select to include Date Navigator, Appointments, Tasks List, or Quick Contacts.

Click Options to display the To-Do Bar dialog box. Select from the options Show Date
Navigator, Number of month rows, Show Appointments, Show All Day Events, Show Details of oo
Private Items, Show Task List, Show Quick Contacts and/or Show contact photo. )

4.  Click OK.
Click the Arrow in the upper left to collapse/expand the To-Do Bar. Click the horizontal divider and

drag up/down to adjust the display area for the Tasks, etc.

NEW TaSkS &ld 9 u ] — Ccmulelepéi-‘img‘G‘r\m\‘eladthfloo'-hsk = EE‘)
Create a New Task HXam A% v & & O WY
1.  Click the Task icon in the Navigation Pane to display the b e

Tasks folder. © cuen i don

Subject Camplete packing for move to 4th floor

2. When in the Tasks, click New Task on the Home Tab or
use the shortcut keystroke Ctrl+N to create a new task.
When not displaying the Tasks, use the keystroke —
Ctrl+Shift+K to create a new task. The New Task dialog
box displays.

Tha 3/28/2013 - | satus: [ Progress

Due date: Fri 4/5/2013 v | priority: [Normal | v | w complete: [40% |2

3.  Enter a textual description for the task in the Subject
field.

4. Enter a Start date, Due date, Status, Priority and %
completed in the fields provided.

5. Enable the Reminder checkbox and set the reminder b 3
date and time.

6.  Use the features on the Task command tabs (discussed in the section entitled Task Window Command Tabs at
page 4) to insert items, format text, mark private or spellcheck.

7.  Click Save & Close.

& = Working with Tasks again - Task

Assign a Task SR ==
1. Follow steps 1-5 above. H X L“J A% Q ,ﬁ o - v
2. Click Assign Task to delegate the task to another person. . e t] o

A To field displays along with two checkboxes with owner :
monitoring options.

3.  Click the checkbox to enable/disable Keep an updated
copy of this task on my task list.

4.  Click the checkbox to enable/disable Send me a status
report when this task is complete.

5. Click Save & Close.

To view tasks you have assigned to others, from the Task folder,
click Home Tab [ Assigned view.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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Respond to Task Request

Task Requests are very similar to Meeting Requests, in that they arrive as an e-mail message and should be
responded to via the Task Request window.

1. Open the Task Request message (shown right). & e RSN Rt B it U'L’:
2. Respond via the buttons to Accept, Decline, Reply, X 8 |4 XIS B e~ 8
Reply all, or Forward as appropriate. e, Dt Cree [T e | A0 g erars | o e T 8 towmporonee |

3. Use the features on the Task command tabs
(discussed in the section entitled Task Window
Command Tabs at page 4) to assign the task,
categorize, flag for follow up, mark private or zoom.

4.  Click Assign Task to delegate the task to someone
else.

5. Click Send Status Report to forward send a status
report to the delegator of the task.

6. Click Save & Close.

Task Window Command Tabs

Task Command Tab: Actions, Show, Manage Task, Recurrence, Tags and Zoom

Task Insert Format Text Review Add-Ins & @
y 2 . , x a .
m g‘ ol ,B | " | (&) Private [ 8]
H X o N SRRV AN C m U \
! High Importance
Save & Delete Forward OneMote | Task | Details Mark  Assign Send Status | Recurrence  Categorize Follow Zoom
Close Complete Task Report - Up~ 4 Low Importance
Actions Show Manage Task Recurrence Tags Zoom

e  Outlook tasks can be used to capture billable information related for accounting and timekeeping purposes. Click
Details to display the additional fields Date completed, Total work, Mileage, Actual work, Billing
information and Company.

e C(lick Forward to attach the task to an e-mail message.

e Click Mark Complete to change the task from active to completed.

e Click Assign Task to delegate the task to another party. You can monitor the task through the Assigned view.
e C(lick Send Status Report to update the owner of a task assigned to you.

e C(lick Recurrence to create a recurring pattern for the task. See the section entitled Create a Recurring Task at
page 5 for more information.

e C(lick Follow Up to flag the task.

e  C(lick Private to mark the task private and therefore prohibit even delegates with access to your task from
reading the full detail.

e  (lick High Importance or Low importance to tag the task appropriately.
e C(lick Zoom to adjust the display view.

Insert Command Tab: Include, Tables, Illustrations, Links, Text and Symbols

1 Task Insert Format Text Review Add-Ins
e ] EE DY o Q A A = A=
] y J B W 4= g+ . = =
4 @ b F 2 ol = @ £ oae s e 2 %
Attach  Outlook Business Signature | Table | Picture  Clip  Shapes Smartart Chart Screenshot Hyperlink Bookmark | Text  Quick WordArt bi Equation Symbol Horizontal
File Ttem Card - M Art M M Box ~ Parts ~ - 8 Object M M Line
Include Tables Tlustrations Links Text Symbols

e  C(lick Attach File to insert a document into the task.
e  C(lick Outlook Item to insert any Outlook item (Message, Note, etc.) into the task.

e C(lick Business Card to insert a business card for a contact stored in your Contact list.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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e  (Click Signature to display a drop-down list of your stored signatures. Click to select the one to insert.
Instructions to create an Outlook Signature are outlined in the Outlook 2010 for Windows QRG 3 - Mail.

e C(lick Table to insert a table with Word 2010 Table functionality. The Table Tools Design and Layout
Command Tabs display.

e  (Click any of the Illustrations, Links, Text or Symbol commands to insert the appropriate item.

Format Text Command Tab: Clipboard, Font, Paragraph, Style and Editing

Tas| Insert Format Text Review Add-Ins o
\ | Task dd
== - im L a— = o 44 Find -
. A W LB iz L= .4z, &4 - - %ﬁ-‘
B Gl 10 - A & Aac B == (F A9 pncend asmbcend AaBhCe AaBhce AaB L A Replace
Sae
Paste W, ALE=E == 2=~ v I . Change
* F Format painter B I U abe x, x = S E EE E & - TNormal | TNoSpacing Headingl  Heading 2 Title = St;-le:' [ select -
Clipboard D_ Font D_ Paragraph D_ Styles D_ Editing

e Select text to be edited and then click any of the buttons to apply changes: Cut, Copy, Font, Paragraph or Styles.
e (lick Paste to insert cut or copied text.

e  Select the text with the desired formatting then click Format Painter to copy the format one time from the
selected text and paint the same format over newly selected text. Click the Format Painter twice to turn on the
feature and paint

e formatting over selected text multiple times. Click Format Painter once to turn it off.
e  C(Click the Clipboard, Font, Paragraph or Style dialog box launchers to display the full dialog boxes for each set
of commands.

Review Command Tab: Proofing and Language

‘ ‘ Task Insert Format Text Review Add-Ins

= ABC 5
YV @ WM % %
Spelling & Research Thesaurus Word | Translate Language
Grammar Count hd

Proofing Language

e  C(lick Spelling & Grammar to check the spelling or grammar of the appointment.
e Click Research to display the Research Task Pane with fields to search reference materials and online.

e  Select text and click Thesaurus to find a synonym of the selected word.

Create a Recurring Task

1. Onthe Task Tab, click Recurrence. The Task Recurrence Task Recurrence =
dialog box displays (shown right). Recurrence patern
2.  Establish the recurring pattern by select from Daily, - :w e )
eekly Sunday Monday 7| Tuesday Wednesday
Weekly, Monthly or Yearly. - nurstny iy soturcay
3.  Enter the number of recurrences in the Recur every [ ] vearly Regenerate new task |1 | week(s) after each task is completed

weeks / months / or years field (field changes based on
recurring pattern selection).

Range of recurrence

Start:  Tue 3/26/2013 [z] ©no end date
4. Select the days of the week on which the task should be @ Endafter: 10| sccurrences
Completed' End by: Tue 5/28/2013 =]
5. Inthe Range of Recurrence section, select the Start ox canccim| | Remove Recurrence

Date.

6.  Select the range of recurrences to End after [ ]
occurrences or to End by a specified date.

Never select No end date as the recurrence will continue forward in time without end. Rather, end recurring items at the
end of the current year and create a new recurring item for the next year. Recurring tasks that carry over through several
years can become corrupt over time and causes performance issues in Outlook.

Also, do not include attachments in recurring items. Attachments will be included in every instance of the recurring item
which will use valuable server space toward your Outlook mailbox maximum quota size.

7.  Click OK when complete.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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Click File Tab | Options | Tasks to display the Task options and change how you work with your tasks.
Task Options:

Click the checkbox to enable/disable the option Set reminders on tasks with due dates.

Click the drop-down arrow for Default reminder time and select the time to be reminded on tasks with due

dates.

Click the checkbox to enable/disable the option Keep my task list updated with copies of tasks I assign to

other people.

Click the checkbox to enable/disable the option to automatically Send status report when I complete an

assigned task.

Click the drop-down arrow for Overdue task color and select from the options provided.

Click the drop-down arrow for Completed task color and select from the options provided.

Click Quick Click to set the default behavior when single-clicking on the Flags column in the Mail folder. The Set
Quick Click dialog box displays. Click the drop-down arrow and select the single-click Flag default.

Tasks Options: Work Hours

Click the drop-down arrow for the Task working hours per day to select the number of hours you work each

day.

Click the drop-down arrow for the Task working hours per week to select the number of yours you work each

week.

Task Shortcut Keystrokes

To do this Press
Show or hide the To-Do Bar. ALT+F2
IAccept a task request. ALT+C
Decline a task request. ALT+D
Find a task or other item. CTRL+E

Open the Go to Folder dialog box. CTRL+Y

Create a task (when in Tasks). CTRL+N
Create a task (from any Outlook view). CTRL+SHIFT+K
Open selected item. CTRL+0
Print selected item. CTRL+P

To do this Press

Select all items. CTRL+A

Delete selected item. CTRL+D

Forward a task as an attachment. CTRL+F

Create a task request. CTRL+SHIFT+ALT+U

Switch between the Navigation Pane, TAB or SHIFT+TAB
Tasks list, and To-Do Bar.

Open selected item as a Journal item. CTRL+]
Undo last action. CTRL+Z
Flag an item or mark complete. INSERT
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